LX Event Software
Operator’s Manual
for use with NorthEast Monitoring’s
DR200/HE and DR300
and other cardia looping
event recorders
Software Version 2.11C

Part number: NEMM016_Rev_H
Last updated: May 2017
Copyright 2007 - 2017
All rights reserved

LX Event Operator’s Manual

NorthEast Monitoring is an FDA Registered Facility, number 1224919,
that follows all FDA CGMP Manufacturing Practices.
The LX Event software has been developed by NorthEast Monitoring, Inc.
The LX Event software has FDA 510(k) Market Approval Number K070014.
This product, like all Holter monitoring products,
should be used only under the direct supervision
of a licensed physician.

Microsoft Windows 7 and Windows 10
are registered trademarks of Microsoft Corp.
Adobe Acrobat Reader is a registered trademark of Adobe Systems Incorporated.

NorthEast Monitoring, Inc.

NEMM016_Rev_H

Page 2 of 27

LX Event Operator’s Manual

Table of Contents
Chapter 1 .................................... Introduction 4
System Requirements 4
Operator Knowledge 4
User Specifications 4
Software & Performance Specifications: 5
Intended Use 5
Indications For Use 5
Updating LX Event 6
HASP Software Key 6
New Installations 6
Telephone Interface Unit 7
Technical Support 7

Chapter 2 ....................... Patient Information 8
Add Patient 8
Patient Information 9
Find Patient 11
Deleting Patients 12
Copy Patient 12
Close Patient 12
Back-up Patient Data 12

Chapter 3 Transmissions, Events and Strips 13
Five Ways to Receive a new Transmission 13
Transmission Screen 16
Event Screen 18
Saving Strips 20
Review on toolbar 21
Summary Screen 21

Chapter 4 ...................................... Reporting

22

To Create a Report 22
Customizing Reports 23
Admin Export option 23

Chapter 5 ................. Remote Transmissions
LX Remote 24
Remote Window 25
Wireless transmissions

24

26

Chapter 6 ................. Known Software Issues 27

NorthEast Monitoring, Inc.

NEMM016_Rev_H

Page 3 of 27

1 I NTRODUCTION
Welcome to NorthEast Monitoring’s LX Event Recorder Software. With this software, you can receive and record
transmissions of ECG recorded events, review the events, save particular ECG strips of interest, create transmission,
procedure or a summary report. The reports may include full disclosure of patient event recordings.

System Requirements
The LX Event software can be used with NorthEast Monitoring’s DR200/HE or DR300
recorder, or with any event recorder that uses direct FM modulation. To run the LX
Event software, your personal computer should include:
1.
2.
3.
4.
5.
6.
7.

Microsoft Windows 7 or Windows 10 Operating System
processor with a speed of 1 GHz or faster
at least 1 GB of working memory
monitor with a resolution of at least 1280 x 1024
disk drive of at least 10 GB
standard analog (POTS) phone line for receiving telephonic transmissions
laser printer is recommended

Operator Knowledge
To use NorthEast Monitoring LX Event software, you must have extensive ECG
knowledge that allows you to properly identify sinus and paced rhythms, abnormal
rhythms, supraventricular and ventricular arrhythmias, artifact, ST segment changes,
and pacemaker failures. In addition, all instructions assume a working knowledge of
computers and, specifically, Windows software.

User Specifications
The LX Event Software is designed to be used by a trained operator under the supervision of a licensed clinician for the purpose of evaluating the ECG captured as part of an
automatic or manually saved recording event.

NorthEast Monitoring, Inc.
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Software & Performance Specifications:

Software & Performance
Specifications:
Display capability:
1. Display ECG data as a full transmission
2. Display ECG data as individual events when
recorded by a NorthEast Monitoring recorder
3. Sequentially display both channels of a two
channel recording.
4. Label recordings made from the NorthEast
Monitoring recorders with time, date and event
type.
5. Display in a full disclosure in a scale of from
0.25 to 4x normal with from 3.75 to 60 seconds
of data per line of the display.
6. Measure PR, QRS, QT, ST, and HR values
using cursors which can be positioned on the
ECG data.

Recorder capability:
1. Data from NorthEast Monitoring DR200/HE
& DR300 recorders can be displayed with all
time, date and event labels.
2. Data from non-NorthEast Monitoring recorders can be displayed as unlabeled ECG if they
transmit their data using a FM Acoustic system
with a 1.9 KHz carrier.
3. Maximum recording length: Recorder limited.
4. Data transmission methods:
4.1. Acoustic FM with 1.9 KHz carrier by
phone (POTS line) or local microphone.
4.2. SD card from NorthEast Monitoring
Recorders
4.3. Remote transmission via LX Remote website
4.4. Wirelessly using the DR300 Wireless feature

NorthEast Monitoring, Inc.

Intended Use
The LX Event Software is a data management program intended to be used with DR200/HE and
DR300 and/or an equivalent recorder for diagnostic evaluation of transient symptoms such as dizziness, palpitations, syncope and chest pain. The
system provides single lead or multiple lead ECG
morphology, which may be used to visualize
arrhythmias, ST segment changes, SVT, heart
block, re-entrant phenomena, and p-waves. The
system may be used with pacemaker patients to
assess pacemaker activity. The LX Event Software is to be used only on the order of a physician.

Indications For Use
The LX Event Software is intended to be used
with the DR200/HE and the DR300 recorders. The
DR200/HE and DR300 module is a patient activated device designed to record and for diagnostic
evaluation of transient symptoms (such as dizziness, palpitations, syncope, and chest pain). Once
data is recorded, the data is transmitted via telephone for evaluation. The device includes the auto
detect feature which can be used as a looping
event recorder to capture events automatically or
when activated by the patient. When one or more
events are captured the patient may transmit his/
her recordings transtelephonically.

NEMM016_Rev_H
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Updating LX Event

Updating LX Event

To View Sample Patients

See the readme.txt file included with the install
files for important information and guidance in
updating from previous versions of LX Event.

Note: Do not load the sample patient data if
you already have existing patients, as the
Sample Patient data will overwrite your existing
patients.

This version of the software requires a HASP
software key and a new license.ini file. Contact
NorthEast Monitoring or your representative for
more information.

HASP Software Key
Once installed, the HASPFinder software found
under “NorthEast Monitoring” on the All Programs list, will look up and show you where the
HASP software key for LX Event can be found.
The HASP software key must be plugged into
your computer, or a visible network, and a
license.ini file must exist for the LX Event software to run.
For network applications, you will need to install
Safenet’s Sentinel Runtime software on your
server. The install file, HASPUserSetup, can be
found under Utilities on the installation disk

New Installations
To run, the LX Event software must be installed
on the hard disk of your computer. No other programs should be running when you install the LX
Event software.
The installation process should have installed an
LX Event icon on your desktop. LX Event can
also be found in the Start menu by pressing Start
-> All Programs -> NorthEast Monitoring -> LX
Event.
You must first have a HASP software key
plugged in and an installed license file for LX
Event to run.

NorthEast Monitoring, Inc.

For new users only, you can load a set of sample
data for learning or demonstrating the system.
With the LX Event software closed, double-click
on the Sample_Patients executable found on the
installation disk under “Utilities”. Never load the
sample patients if you already have actual
patients saved in your software. Also, be sure to
delete the sample patients before going live with
LX Event.
To view the patients, click on Patient > Patient
Find. You don’t have to enter any data to see a
full list of patients, so just click on “Search”
when the window appears. Now you will see a
list of sample patients. Select a patient by double-clicking on the line, or by clicking on the
patient and then pressing “OK” or the Enter key.
You are now looking at the Event screen for this
patient, and viewing the first event of the last
transmission for that patient. Also, if you go to
the toolbar and click Patient > Patient Info, you
will see the demographic data for your patient.
In Event mode you can save and view strips that
have been previously saved for any event. The
lower-left-hand-corner of the screen shows you
the count for the number of transmissions, events
and strips for your patient.
The two buttons in the upper-left-hand-corner of
the screen allow you to toggle between the Event
and the Transmission screen. The button will be
blue when you are on the screen.
The toolbar item labeled Review, lets you jump
between different screens for the patient. The
Summary screen allows you to see all transmissions, events and strips in a list form. Clicking on
an date/time of an event from the Summary
screen will take you there.

NEMM016_Rev_H

Page 6 of 27

LX Event Operator’s Manual

Telephone Interface Unit

Physician Set-up
You may want to create physician files before
you start adding patients to LX Event. By setting up physicians, you will able to more easily
enter patients when the time comes.
First go to the Physician Edit Screen which can
be found from “File” on the toolbar.

If you have multiple physicians with the same
address, you can easily copy the address information forward by opening a physician you
have set up, changing the Physician ID and
Report Name to the new physician, and then
pressing the Save button.

Telephone Interface Unit
The Telephone Interface Unit (TIU) is an
optional piece of equipment that you can use to
record event transmissions via the telephone or
a local microphone. In order to use the TIU, the
National Instrument Software, provided with
the LX Event install files, must be first
installed on your computer. See readme.txt for
more information on installing the TIU.

File drop-down menu
When you first open the window there is a
drop-down box labeled “Physician ID”. The
Physician ID will help you to find the correct
physician when entering patients. Because it
will not appear on reports, you may want to
enter Last name, First name as the identifier for
each physician.
The Report Name on the Physician Edit screen
will appear on reports, so that should appear
more formal. When entering Physician data on
the Patient record the physician’s Report Name
and Address information will be carried over to
the patient record and will appear on the report.

Technical Support
In addition to the information in this manual,
more information and help is available at our
web site: www.nemon.com or
•
•
•
•

Toll Free USA: 866-346-5837 option 1
Phone: [+1] 978-461-3992 option 1
Fax: [+1] 978-461-5991
e-mail: support@nemon.com

The “Technical Support” page on the web-site
includes Frequently Asked Questions.
The current version of this manual and our
software can always be found on our web-site
on the “Downloads & Documents” page.

Physician Edit Screen

NorthEast Monitoring, Inc.
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2 P ATIENT
I NFORMATION
The LX Event software allows you to set up patients in advance of a transmission. Each patient record directly links
to a single procedure. If a patient has more than one procedure, that patient will have more than one patient record.
Old patient records should have a Procedure Closed Date before a new record is created for the same patient. The
Copy feature allows for easy setup of additional procedure records for the same patient.

Add Patient
When the LX Event program first opens, it displays a blank screen with a standard
toolbar. To enter a new patient, select Patient from the toolbar and choose Patient
Info from the Patient drop-down menu. You will now see a blank Patient Information screen and will be able to set up a new patient. After saving, this patient will
now become the current patient. If the Patient Information screen is not blank and
you want to add a new patient, first select Close Current Patient from the drop-down
menu.

These all can be seen from the Tranmission
Screen:
Patient Info allows you to update the current
or create a new patient.
Find Patient to search for a patient
New Transmission from file allows you to
save a transmission via SD card to the currently open patient.
Delete Transmission to delete the Transmision that you currently have open. Use this
very carefully.
Start Local Recording via microphone.

Patient Drop-Down from Transmission Screen

Copy Patient - create a new patient from
currently open patient.
Close Current Patient to close the window
for currently open patient.

NorthEast Monitoring, Inc.
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Patient Information

Once you are finished
entering a new patient,
press OK to accept/
save or Cancel to exit
without saving.

Patient Dates
On the Patient Info
Screen, the check-box
next to the date must
be checked for the date
to be utilized.
If you know the
patient’s Date of Birth
- DOB - you can enter
it and the age will
automatically be calculated. You can just
enter the age if the date
of birth is unknown.
The Enrolled Date is
the start date of the
procedure - when the
patient is instructed to
begin wearing the
event recorder.

Patient Information Window

Note: Before you add your first patient, you
will probably want to set up your physicians.
More information on adding Physician data
can be found at the end of the previous
chapter.

Patient Information
LX Event only requires a patient to have a
name, but it is highly recommended that you
enter the Patient Name, DOB, Phone, Recorder
ID and Referring Physician at a minimum.
That way you will be able to easily find the
patient when a transmission is received.

The Due Back Date is the entered when the
procedure has started. It is the date that you
expect the procedure to end.
The Procedure Closed Date is filled in once
the recorder has been returned. Once a procedure has Closed Date, you can no longer record
to it. You must either remove the Closed Date
or start a new Patient Information record for a
new procedure. You can easily do this by opening the patient and select Copy Patient from the
Patient drop-down menu.

Dates - Entering and adjusting
By clicking on the drop-down, you will see a
calendar that allows you to easily update the

NorthEast Monitoring, Inc.
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Patient Information

dates. Just click on the component of the date
that you want to change and update as required.
Alternatively, you can click on any piece of the
date to easily edit to what you want.

Indications and Medications
Each field has a drop-down box where you can
select one or more entries. You can also edit the
field directly and add or modify what you have
entered.

The Recorder ID
Enter the SN number that is found on your
recorder. For the NorthEast Monitoring
DR200/HE or DR300, this can be found inside
the battery compartment when the battery is
removed. For DR200/HE or DR300 recordings, the SN is also transmitted with the recording, so this will help you to ensure that you are
saving the correct recording to the correct
patient when the time comes.

Be sure that each physician has a Report Name
in the physician file, as this is the name that
will appear on reports.
More on editing the physician record at the end
of the previous chapter.

Procedure Closed date and
Technician
The Procedure Closed date should be entered
after the procedure is finished and before the
recorder is given to a new patient. Once a procedure is closed, you will not be able to assign
any more transmissions to the Procedure.

Status
At the bottom of the Patient Information window, you can update the patient’s status by
clicking on the Edited, Reported, or Verified
buttons. The status fields are visible from the
Patient Found List.

If the Recorder ID is already being used in an
Open Procedure, you will not be able to enter
the Recorder ID without closing the first procedure.

Physician Data
The Referring, Copies to, and Interpreting Physician data will appear on the report. Click on
the drop-down box to select a physician that
has been set up in the Physician file. Once a
physician has been selected, the address information will be automatically populated and
you can edit any of the information on the
screen, if you like.
If physician data is inaccurate in the physician
file, you should go directly to the physician’s
record to correct so that it will be correct moving forward. Any changes on the physician file
will not automatically update patient records
and vice versa.

NorthEast Monitoring, Inc.
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Find Patient

Begins with “Smith”
Patient DOB checked to search
Contains the value Z anywhere w/ “*”
Implied “And” - All three conditions
need to be met for the patient to be
selected.

Patient Find

Find Patient
Select Patient Find from the Patient drop-down
menu to:
•
•
•

find a patient record for a new transmission
ensure that the patient does not already
have an open procedure before adding anew
find and copy past patient data for a new
procedure.

Patient Find Logic
To find your patient, you can enter data in one
or more boxes at a time. Use the following
logic when searching:
Begins with. The default search logic is
“begins with”, so you should enter at least the
first few characters or numbers of the field to
search.
Contains *. If you need to search within a
field, you need to enter an asterisk * before the
search criteria. For example, if you know the
last 4 digits of the phone number is “1234”,
then you need to enter “*1234” in the Patient
Phone field and all phone numbers that contain
1234, will be selected.
Patient DOB. Check the Patient DOB box to
search and uncheck to ignore. Use either the
calendar or click on each part of the date to
update with the patient’s birth date.

NorthEast Monitoring, Inc.

Implied “And”. If more than one item is
entered in the search criteria, it is an implied
AND. For Example, if you enter both a Patient
Name and Patient DOB, both criteria will need
to be met for a patient to be selected.

Found Patient List
After a search (Find Patient), all selected
patients are presented in a scrollable list.
If you see the patient you are looking for, you
can either select the line and press OK, or double-click on the patient line. You will then be
taken to the last transmission for that patient’s
procedure. Once a patient is selected, you can
click on Patient Info from the toolbar to see
the details for that record. You can edit the
information at this time.
If a patient has more than one entry, the Date
Enrolled and Procedure Closed Date will help
you to decide which record is appropriate to
use. If there are no open procedures - a procedure with no Closed Date - you may want to
select patient and then select Copy from the
Patient drop-down box. You will now see a
new Patient Info record that you can edit as
required.
If you do not see the patient on the list, simply
cancel out of (or Close the patient that is open)
and click on Patient Info. You will now see a
blank Patient Information screen for entering

NEMM016_Rev_H
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Deleting Patients

Found Patient List
the new patient. Click OK when finished and
the new patient is now saved in the system.
If a patient name is preceded by an asterisk *,
this means that the patient is already opened by
you or another user and cannot be opened again
at this time.

Deleting Patients
For this release, Patient Delete has been disabled. For the short-term, users should just
close the Procedure if they choose to no longer
have a patient Active.

Copy Patient
The Copy Patient function will copy the current patient’s data into a new patient record.
This should be used when you are opening a
new procedure for a patient who has a closed
procedure. The copy function does not copy
ECG data, just the Patient Info record.

Back-up Patient Data
It is highly recommended that you back-up and
save your patient files separately from your
computer on a regular basis.
A batch file has been included in your software
that allows you to save a copy of the patient
event files. This file can be found in
c:\nm\Lxevent\patientbackup.bat. This batch
file will copy all of your patient files into a zip
file on your D: drive. If you wish to backup to a
different location, you will need to edit the
batch file to point to your desired location.
The directory name that is created is
LX_EVENT_PATIENT_BACKUP_999.zip,
with 999 being an arbitrarily assigned number.
The date of the backup is the Modified Date of
the zip file. If you wish to save this file on a
CD, you will first need to save it locally and
then copy it to the CD.

Close Patient
If a patient is already open and you would like
to enter another, you should first close the current patient. Do this by clicking on the Close
Patient button or selecting Close Current
Patient from the drop-down box. When you see
“No Procedure Loaded” at the top of the
screen, this means that no patient is currently
selected. You can now enter a new patient by
clicking on Patient Info.

NorthEast Monitoring, Inc.
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3 TRANSMISSIONS ,
E VENTS AND STRIPS
A transmission is a recording with one or more events. When a patient calls with events, you can begin recording the
transmission before or after you have identified the patient in the system. If you cannot find the patient or the patient
does not have an open procedure, you can set up new patient information during or after you finish recording the
transmission. A patient can have multiple transmissions applied to a single procedure. If a procedure is ended, you
will need to create a new record for the patient with a new Enrolled Date.
Note: Always be sure to Close the current patient before you begin recording a transmission for a different
patient.

Patient Info Record
Each patient must have an open Patient Info record - a record with no Procedure
Closed Date - in order to receive a new transmission. If a procedure is closed and a
new transmission has arrived, you can either:
•
•

Open a new Patient Info record for the patient by copying the existing patient
information to a new blank record, or
Remove the Procedure Closed Date from the patient’s last record in order to reopen it. (This should only be done if the last procedure should not have been
closed.)

Five Ways to Receive a new Transmission
LX Event allows you to record and/or save transmissions to an open procedure in
six different ways. A Telephone Interface Unit (TIU) is required for the first two.
Telephone
Local recording via microphone
3. SD Flashcard with DR200/HE or DR300 recorder
4. Remote transmission via LX Remote with DR200/HE or DR300 recorder
5. Wirelessly using a DR300 recorder
1.
2.

In all cases, you can select the patient before, during or after the transmission has
taken place. A procedure may consist of one or more transmissions and you can
continue receiving transmissions for a patient until a Procedure Closed Date is
entered onto the Patient’s record.

NorthEast Monitoring, Inc.
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Five Ways to Receive a new Transmission

Transmission Mode (blue)

Transmission mode Tool-bar

Start telephone recording

1. Telephone Transmission

3. SD flashcard Recording

You can begin recording a transmission after
answering the phone. In order to do this:

If you are using a NorthEast Monitoring DR200/HE
or DR300 recorder for Event monitoring, you have
an additional feature of saving event data onto an
SD flashcard and then loading the ECG recordings
directly onto the computer.

•
•
•
•
•
•

Save any information that is on your desktop
that you want to keep
If another patient is open, go to the toolbar and
select Patient > Close
Find and/or enter the new Patient Information
Press the green Phone Rec button to begin recording
Instruct patient to press Send
button on recorder
The Phone Rec button that
was once green is now red
and reads Stop Rec. Once you
are finished receiving the transmission, press the
red Stop Rec button at the top of the screen to
stop recording

2. Local Recording
The process for recording on your desktop via a
microphone is similar to a telephone transmission,
however, you will need choose Start Local
Recording from the Transmission mode Patient
drop-down box.

Initialize SD flashcard. In order to save data on
the flashcard, the card must first be formatted with
an event.dat file. Do this by placing the flashcard in
your PC card reader and click on Initialize Flashcard from the File drop-down menu. A screen will
appear and you will need to enter the driver letter
where your flashcard is located and press Enter.
Once the flashcard is formatted with an event.dat
file, remove the battery from the recorder, insert the
card into the recorder, reinsert the battery and you
will see that the events are being copies and when it
is finished.
Next, insert the SD flashcard into card reader supplied with LX Event software.
• Start the upload process by choosing New
Transmission From File from the Patient dropdown box.

If no card is found, you will see the message, “No
event.dat file found”. This means that LX Event
cannot find the file. Make sure that the card reader
NorthEast Monitoring, Inc.
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Five Ways to Receive a new Transmission

is plugged in and the flashcard is inserted into the
reader properly. If this is not the issue, sometimes
removing the card reader’s USB plug from the
computer and inserting it into a new location
solves the problem.
Note: The first time you try this you may get a
screen that asks you if you want to Quit or
Continue as it cannot find the file. Keep pressing
Continue until you find the card and then you
should not see this screen again.

4. Remote Transmissions
You will able to receive event files from other
locations when you set up a Remote account with
NorthEast Monitoring’s LX Remote web-site. The
sender of the event files only needs a DR200/HE
or DR300 recorder and does not need to have LX
Event installed on their computer to send the
event.dat files.
For more information on this topic, see
Chapter 5 - Remote Transmissions.

5. Wireless
The DR300 recorder also has the capability to
send files via the cellphone network using a Gateway. In order to receive these files you must have
NorthEast Monitoring’s Wireless software
installed on at least one desktop.
Information on how to set up and receive transmissions wirelessly can be found in the DR300 manual.
Once wireless transmissions are received, they can
be viewed and saved using the LX Remote feature
of the LX Event software.

NorthEast Monitoring, Inc.
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Transmission Screen

Transmission Screen

Review the Transmission

Transmission Colors
When the transmission is recording onto LX
Event, the ECG signal is white. Once the transmission is finished and you press the Stop Rec button,
the transmission may now appear in two colors:
•
•

White - identified as being part of an event.
Yellow - not identified as being part of an
event.

After recording stops, LX Event goes into Event
mode and the first event will appear on the screen.
If LX Event was unable to identify unique events,
the entire transmission will be identified as a single event. To review the entire transmission, you
will need to click the Transmission button to
return to Transmission mode.

Once you finish receiving a transmission, you may
want to adjust filters and settings. You should do
this prior to saving any strips for the transmission.
Whether you are in Transmission or Event mode,
all filter and setting changes will be applied to the
entire transmission.

Gain
To change the amplitude of the
displayed signal, click on the
Gain field and select a different
size from the list.

High Pass Filter
To adjust the High Pass filter,
click on the drop-down box
labeled HP. This filter will allow
you to reduce baseline wander.

Transmission vs. Event mode
The main screen will be in one of two modes at all
times - Transmission or Event. You can tell what
mode you are in as the corresponding button will
be blue in the upper left-hand corner of the screen.

Low Pass Filter
To adjust the Low Pass filter,
click on the drop-down box
labeled LP. This filter will
allow you to reduce muscle
noise and electrical artifact.

Invert ECG and Sec/Row:

Transmission-mode selected
In Transmission mode, you can view all transmissions for a given patient/procedure, record a new
transmission for the patient, and delete and/or add
events to an existing transmission. You can also
delete the Patient or transmission that you currently have opened.

To invert the ECG
signal, check or
uncheck the
Inverted box.
To adjust the
amount of time in
each row of the ECG, click on the drop-down box
labeled Sec/Row and choose the amount of seconds in each row.

In Event mode, you can review each event that
was created either automatically or manually for
the selected transmission, by scrolling through
they events. You can also review and/or create
strips for the events in event mode. You can also
delete events and strips.

NorthEast Monitoring, Inc.
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Transmission Screen

Speed
To set the Transmission
Speed, click on the dropdown box next to the field and
select the speed that is on the
recorder.
If a DR200/HE or DR300
recorder was used, the speed
may be set for you and therefore cannot be overridden.

transmission will be saved for current patient. After
re-importing, be sure to delete the same transmission from the patient record where it did not belong.

Delete a Transmission
You can delete the transmission that is currently on
the screen by selecting Delete Transmission from
the Patient drop-down box while in Transmission
mode. You can delete any transmission at any time,
but you can only re-import the last received transmission.

Transmission Time Date

To update the time and date of the transmission,
click within the field and edit as desired. Press the
TAB key when you are finished and the changes
will be saved. You may want to do this if the actual
transmission time was different from when it was
recorded in LX Event.

R-Wave Markers and HR
The LX Event software attempts to label each Rwave with a red dot and then calculates the HR
based on the RR-intervals. The HR calculation has
a limit of 180 HR.

Previous/Next Transmissions
While in Transmission mode, you can view previous transmissions for the patient by clicking on the
Previous and Next buttons on the upper-right side
of the screen.
You can also tell how many transmissions exist for
a patient by looking in the lower left-hand side of
the screen for the transmission.

Re-import a Transmission
Immediately after recording a transmission, you can
re-import it. This feature should be used if you accidently recorded a transmission to the wrong patient
or the patient did not exist in the system while
recording. First, identify and open or create the
patient to whom the transmission should apply. Second, go to Help > Utilities > Re-import Last
Saved Transmission. Respond “Yes” and the
NorthEast Monitoring, Inc.

NEMM016_Rev_H

Page 17 of 27

LX Event Operator’s Manual

Event Screen

Event Mode Event button is
blue
Event Time and
Date. Can be edited
by updating and
pressing Tab.
Strip that is currently
in edit bar below
denoted by red
bull’s-eye

Strip Edit Bar for marking,
measuring and
labeling strips for
reports
Event-mode Screen

Event Screen
A transmission is composed of one or more events. An
event is when the patient experienced a cardiac symptom and either pressed the button or the event was
sensed automatically.
LX Event attempts to identify events as the transmission is being recorded onto the desktop. For DR200/
HE and DR300 recordings, the event may also be
saved with the time/date of the event and type of the
event - Manual, AF_Event, Brady, Tachy, Pause or
with an entry that the patient selected. This will not
occur, however, if the signal is too weak, the signal has
too much phone line or microphone noise, or you are
not using a NorthEast Monitoring event recorder

hand side of the screen. In this example, you can see
that there are two events for this transmission:

You can now toggle between each event that was identified during the transmission by clicking on the Event
button on the top-left of the screen.

Note: If you get to the end of one Transmission and
click on Previous or Next Event, LX Event will take
you to the previous or next transmission.

View Events
If events have been identified by LX Event, you will be
able to tell as a portion or all of the ECG is white
(included in event) and by the tally at the bottom left-

NorthEast Monitoring, Inc.
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Event Screen

Event Time Date

the beginning and then at the end of the new event.
The event will turn white. Continue to do this until all
events are identified, and then click on the Event button to begin identifying strips.

If you have created an event or LX Event was not able
to determine the time or date of the event, you can
update them if you like. To update the time and date
of the event, click within the field and edit as desired.
Press the TAB key when you are finished and the
changes will be saved.

Event Type
If your recording was saved using a NorthEast Monitoring’s DR200/HE or DR300 recorder, the event type
that was saved during the recording will appear here.
If the event was recorded automatically by the
recorder, you will see either Tachy, Brady, AF_Event
or Pause. If the patient had pressed the button in order
to record an event, then either Manual, Skipped Beat,
Short of Breath, Rapid Heart, Chest Pressure, Dizziness, or Chest Pain will appear, depending on what
your patient had chosen at the time of the event.

Diary Symptoms
If your patient kept a diary, you may want to enter any
symptoms they were experiencing or what they were
doing at the time of the Event. You can either select
from the drop-down box or add one of your own.

Channels

If you make an error adding an event, you can easily
delete it by going into Event mode, viewing the incorrect Event, and then pressing Delete Event from the
Event drop-down.
You will not be able to add an event if one already
exists on that piece of the ECG. If an event has been
previously identified incorrectly, you will need first
delete it and then add the new event.
Note: For any recording in which you have to
create or “Add Event”s, for example, acoustic
recordings from Non-northeast recorders, the
summary reports cannot be produced. Instead, the
Procedure and Transmission reports should be
used.

Delete Events
You may want to delete events if they are not actually
events or you want to create a new event. In order to
delete an event, you must be in Event mode on the
event that you want to delete. When you delete an
event, you are not deleting the ECG from the transmission, just removing its designation as an event.
When you delete an event, however, any strips associated with the event no longer exist, and you will need
to recreate them, if desired.

If a recording was done in 2-channel, you will see a
CH2 above the Diary Symptom. Otherwise that field
will also show CH1.

Add Events
If a transmission is received with multiple events, but
the system has not identified them all, you can identify the events manually. In order to do this, you must
first be in Transmission mode. If you are not in Transmission mode, click the Transmission button and it
will turn blue. You may want to increase the Sec/Row
value at the top of the screen so that you are able to
see the entire transmission while determining where
events begin and end.
First, click on the Add Event button on the top-right
of the screen and then carefully click on the ECG at
NorthEast Monitoring, Inc.
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Saving Strips
Cursor Buttons

Strip Buttons

Strip Time/Date

Segments

Strip at the bottom of the Event Screen

Saving Strips
In Event mode, click on the ECG to identify strips. The blue bull’s-eye shows
where strips have already been saved. A
red bull’s-eye appears when the corresponding strip appears at the bottom of
the screen. Once the strip appears on the
bottom of the screen, you can place cursors, label
and save the strip. Use the Previous and Next Strip
buttons to switch between and view or edit saved
strips.

Strip Measurements
The second row of boxes shows the resulting measurements from cursor placement:
PR: Time difference between Q and P.
QRS: Time difference between S and Q.
QT: Time difference between Q and T.

Cursors
The Default Cursors button at the top-left of the
strip allows you to place all of the cursors at once in
a location determined by LX Event. After pressing
Default Cursors, you can move any of the single cursors by pressing the button for the that cursor and
then clicking on the screen where you want it to go.
Apply single cursors by first clicking on the appropriate cursor button. LX Event will then place the
cursor in the default location, and you are able to
move it by clicking elsewhere on the screen. Once
the cursor is where you want it, select another button
to continue.

NorthEast Monitoring, Inc.

In order to remove a cursor, click on the button and
then click on the Delete Cursor button. If you want
to remove all cursors, the easiest way to do this is to
not save the strip and just click on the transmission
again. This way you can start over easily.

ST: The vertical difference between the values of
the I and ST cursors.
HR: The heart rate is calculated based on R1 and
R2 being 2 RR intervals apart.
XY: X and Y allow you to measure between any
two points on a strip. For screen use only and
will not appear on the strip when reporting.

Save Strip
Once you assign all of the cursors, you can enter a
Strip Label and save the strip by pressing the Save
Strip button.

NEMM016_Rev_H
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Review on toolbar

Notes
Once a strip is saved, a gray Notes button will
appear. Notes entered here will not be printed on any
reports. When Notes exist for a strip, the button will
appear blue.

Edit Strip
To select a previously saved strip, either click on the
bull’s-eye of the strip or use the Previous and Next
Strip buttons till the strip you want to edit appears
on the bottom of the screen. Once the strip appears,
you can edit it and save the changes by pressing the
Save Strip button. If a strip needs to be extensively
edited, you may want to delete it and then start over.

Delete Strip
To delete a strip, select the strip so that it appears at
the bottom of the screen and click on Event > Delete
Strip.

Save Events as Strips
If you would like an entire event to be saved as
strips, use the Save Event as Strips button. Enter the
Strip Label first, and that label will be applied to all
of the strips. You can then go back and edit each strip
if desired.

Review on toolbar
The Review dropdown menu on the
toolbar allows you
to quickly jump
from one screen to
another. Go to the
appropriate screen
by either clicking
on it or by selecting
the appropriate
function key.

Findings
The Transmission and Procedure Findings screens
are accessible via the Review toolbar or the appropriate function key. On these screens, you are able to
enter up to 12 lines of text that will appear on the
reports. The Procedure Findings that you enter here
will apply to all transmissions that exist for this procedure. On the Transmission Findings screen, you
can denote whether a Transmission has been Edited
and/or Reported. These items will also appear on the
Summary Screen depicted below.

Summary Screen
The Summary Screen allows you to see all of the
patient’s transmissions, events and strips in one location. After at least one transmission has been
recorded, go to the Summary Screen by pressing the
Summary button on the Patient Find screen, on the
main screen, or by pressing F6. Once you are on the
Summary Screen, double-click on the appropriate
line to be taken directly to the exact event and/or
strip you have chosen.

Summary Screen

NorthEast Monitoring, Inc.
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4 R EPORTING
LX Event has four reports for the user to choose from:
1) Transmission Report for a single transmission which includes all saved strips and an optional full disclosure,
and
2) Procedure Report that includes all transmissions for a procedure. It also includes all saved strips and has an
optional full disclosure.
3) A procedure level Summary Report that includes a list with counts of transmissions, events and strips, along
with findings. Strips and full disclosure do not appear on this report.
4) A Summary with Strips Report that consists of a Summary Report, above, and all strips for the procedure.

To Create a Report
Reports can be produced or reviewed at any time. In order to create a report:
1.
2.
3.
4.
5.

6.
7.
8.

Find and open the patient and procedure or transmission you want to create the
report for.
Save strips and enter findings for transmission and/or procedure.
Go to File on the tool bar and
click on Print Report,
Next you will see the Print
Settings window.
Click the appropriate button to
select either a Transmission,
Procedure, Summary or Summary with Strips report.
Choose Full Disclosure, if
desired.
Click Print Report when you
are ready to create the report.
An Adobe window will now
appear with your report. The
report will also be saved in the
patient file for reviewing and
printing later, if you choose.

Note: For any recording in
which you have to create or
Print Settings window
“Add Event”s, for example,
acoustic recordings from Nonnortheast recorders, the summary reports cannot be produced. Instead, the
Procedure and Transmission reports should be used.

NorthEast Monitoring, Inc.
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Customizing Reports

To View Existing Reports

Customizing Reports

All reports that you created previously have
been saved in a directory for each patient.
When you click on View Existing Reports, you
will be taken to the directory that includes all
reports that were ever created for the current
patient. Transmission Reports will be labeled
with the number of the transmission that is
reported. If full disclosure is chosen, FD will
appear in the name of the report.You can view
any of the existing reports by clicking on them.

Two files in the Programs Directory can be
updated so that your reports can include your
company’s logo, name and address.

Report Logo
You can include your organizations’s logo on
the report. Do this by saving a jpg file of your
company logo in c:/nm/Lxevent/PrintSpec with
the name logo.jpg.

Report Name and Address
Your organization’s name and address and/or
phone can also be added to the report. In order
to do this, you will need to edit a file that
comes with LX Event with the information that
should appear with the report. The file is limited to five lines of text.
You should edit the file with Notepad only.
Notepad can be found under All Programs->
Accessories. The file you need to edit is

View Existing Reports

Report Send
To copy and save a report in another location
and/or to send a report via LX Remote, use the
Report Send button to save an existing report in
a location of your choice. For LX Remote, you
should place the report in a directory labeled
specifically for the user that you want to send
the report to. See Chapter 5 - LX Remote for
more information.

To Delete Reports
If you create a new version of report and want
to delete an older version, you can do it from
this window also. You can also copy and paste
reports from this folder to another. You should
never change the directory name or path, however, as the system will not know where to look
for the reports moving forward.

NorthEast Monitoring, Inc.

c:/nm/Lxevent/ServiceAddressHeader.ini.
If for some reason you do not want to your
organization’s name to appear at the top of the
report, you should save the file, but it should be
an empty file with all blank lines.

Admin Export option
An executable, decodeevendatabase.exe, has
been provided with your install. This file
enables you to create a complete download of
the administrative information for all transmissions in the system. The output is a csv file in
c:\nm\reports which can be read as is or pulled
into Excel. This file is for administrative use
only.
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5 R EMOTE TRANSMISSIONS
You will be able to receive DR200/HE and DR300 event files from other locations when you set up a Remote account
with NorthEast Monitoring LX Remote software. The sender of the event files only needs a DR200/HE or DR300
recorder and does not need to have LX Event installed on their computer to send the event.dat files.
In order to set up a Remote account for you and your remote locations, contact your channel partner or NorthEast
Monitoring. Complete setup instructions and more information can be found by reviewing the LX Remote manual on
our web-site.

LX Remote
NorthEast’s Automated Remote Process (NARP)
NorthEast’s Automated Remote Process (NARP), must be running on your computer or a
computer/server in your facility that you have access to. The NARP will do the following:
Go to the web-site, download and decrypt event.dat files that are uploaded by your customers.
2. Delete the files from the web-site once you load them into your LX Event patient data
base.
3. Upload reports back to the web-site for delivery to your customers.
1.

Technical Set up for LX Remote to work with LX Event
You will need to turn on the LX Event Remote feature by updating the LX event.ini file that
is found in the c:\nm\lxevent directory, or wherever the software was loaded onto your system. The items in the LX event.ini file that are used to process Remote files are listed below
with their default locations. The first time it is run, the NARP process creates a narp.ini in
c:\nm\narp and the first three pointers need to point to the same locations. You will need to
close, update the ini files, and restart the applications in order for the updated pointers to
work.
“NARP_Running” in LX Event.ini must be set to “true” for the Remote screen to be accessible in LX Event.

Notes

lxevent.ini

Should be changed to “true”
if NARP is running

[NARP_Running]= true

Where the downloaded
event.dat files are saved

[RemoteEventDataDirectory]=
"c:\nm\ftp\Event\"

narp.ini

DownloadDirectory =
c:\nm\ftp
(NARP creates “Event”
directory automatically)

Where the reports should be
placed

NorthEast Monitoring, Inc.

[RemoteEventReportDirectory]=
"c:\nm\reports\"
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UploadDirectory =
c:\nm\reports
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Remote Window

Patient Information for matching
The system will automatically identify patients
for remote records coming in, if you input the
Serial number from the DR200/HE or DR300
recorder into the Recorder ID on the Patient
Information window. The Serial number can be
found in the recorder inside the battery compartment.

In order for matching to work correctly,
only one patient at a time can have an open
procedure with the same recorder ID. To close
a procedure, you must assign a Procedure
Closed Date on the patient’s record where they
no longer have a recorder. After a procedure is
closed, you can continue to report on it, you
just cannot save any additional transmissions
for that procedure.

Remote button
If LX Event has been set up to show Remote
files, you will see a button on the top right of
the screen.
- A yellow button tells you
that Remote files are available to be assigned.

- A green button tells you
that there are no files to
assign at this time.

Remote Window
When you click on the Remote button, you will
open the Remote window. On the window you
will see a list of current Remote or Wireless
files.
The first set of columns, reflects the data from
the incoming file:
•
•
•
•
•
•

Date/Time - when the file was downloaded
Remote User - the customer who sent the
file to you
Name - patient name on incoming file
DOB- Patient date of birth
Physician - the patient’s physician
Recorder SN from the file

For Wireless DR300 files, only the Recorder
SN comes through on the files and the Remote
User and Name are set to “DR300 Holter” and
“event”, respectively
The Remote window will automatically match
an incoming event file with a currently existing
patient in LX Event using Recorder SN and
open procedures only. When matched, the next

Remote window
NorthEast Monitoring, Inc.
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DR300 Wireless Transmissions

three columns will be populated with LX Event
patient information:
•
•
•

LX Name - patient name
LX DOB - patient date of birth
LX Physician

These columns are populated to allow you to
be sure that the files have matched to the
patient you expect.

The Assign button
Click on one or more Remote transmissions
and then the Assign button to copy the transmission(s) to a Patient in LX Event.
Once the Assign button is pressed, LX Event
will ask if you want to assign the file to the
patient identified, answer “Yes” if so, but
answer “No” if you would like to find the
patient yourself. However, if a remote file does

not match to a patient, you will probably want
to check the patient files first to ensure that you
have an open procedure for that recorder SN. If
the procedure has been closed, you will need to
reopen it in order to assign a transmission.

The Delete button
Once a record is assigned, it will automatically
be deleted from the window, so you may never
need to use this button. Use this button carefully, if at all.

DR300 Wireless
Transmissions
The DR300 recorder is able to transmit recordings wirelessly using Bluetooth and the cell
phone network. The Remote screen allows you
to retrieve your wireless transmissions,
whether you are using the Remote feature or
not. If you are also using the Remote feature,
many of the directories that you are pointing to,
must be the same for wireless.
The Socket program that comes with the
DR300 recorders must be running to receive
the wireless records. Similar to the remote
setup discussed earlier in this chapter, the
pointers in both lxevent.ini and wireless.ini
must be set up in order for the wireless records
to be received. See table below.
Please refer to the DR300 Recorder and the
DR300 Gateway and Socket Manuals for
instructions on running the Wireless feature on
the recorder and running the Socket program.
Both manuals can be found at
www.nemon.comon the Downloads & Documents page.

Notes

lxevent.ini

Should be changed to “true”
if Wireless is running

[Wireless_Running]= true

Where the downloaded
event.dat files are saved.
Must be the same as narp.ini
if Remote is running.

[RemoteEventDataDirectory]=
"c:\nm\ftp\Event\"

NorthEast Monitoring, Inc.

wireless.ini

event_destination_path =
c:\nm\ftp\Event\
(narp creates “Event”
directory automatically)
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6 K NOWN S OFTWARE
I SSUES
The following is a list of issues that have been identified in this version of the software:
Bug #
1210

Description
On the remote screen, for remote files, the physician from the remote file does not appear on the screen

1212

Delete patient does not work in this release

1213

The automatic link between LX Event and HE/LX Analysis for Both mode recording does not work in this
release. It will work in the next release of HE/LX Analysis.

1214

If two users are assigning Remote files at the same
time, sometimes the network is slow in closing one
file and deleting the Lock file. When this occurs, the
second user will see the following error message. If
this ever occurs, the user should just click Continue
and try again. as this error will result in no changes
to the patient data or remote files.

1215

For any recording in which you have to create or “Add Event”s, for example, acoustic recordings from Nonnortheast recorders, the summary reports cannot be produced. Instead, the Procedure and Transmission
reports should be used.
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